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Software License Agreement 
This Software License Agreement (“License Agreement”) is a legal agreement between you (either an individual or a single entity) 
and Serif (Europe) Ltd. (“Serif”) for the accompanying software product, which includes computer software and may include 
associated media, printed materials, and “online” or electronic documentation (the “Software Product”). By installing, copying, or 
otherwise using the Software Product, you agree to be bound by the terms of this License Agreement. If you do not agree to the terms 
and conditions of this License Agreement, do not install or use the Software Product; you may, however, return it to your place of 
purchase for a full refund. 
THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT IS IMPORTANT THAT YOU (THE 
“LICENSEE”) READ THIS NOTICE CAREFULLY. THESE ARE THE ONLY TERMS AND CONDITIONS APPLICABLE TO 
YOUR RIGHTS WITH RESPECT TO THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS PROTECTED BY 
COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY 
LAWS AND TREATIES. THE SOFTWARE PRODUCT IS LICENSED, NOT SOLD. 

  

1. GRANT OF LICENSE 

Serif hereby grants to Licensee a personal, non-exclusive, non-
transferable license (a “License”) to use one (1) copy of the 
Software Product, including any updates thereto, and 
accompanying documentation, if any, provided by Serif, 
according to the terms set forth below. If the Software Product 
is being provided to Licensee as an update or upgrade to 
software which Licensee has previously licensed (such software 
referred to as the “Prior Software”), then Licensee agrees to 
destroy all copies of the Prior Software within thirty (30) days 
after opening this package except for one backup copy of the 
Prior Software. 

 

2. SCOPE OF USE 

You may install and use one copy of the Software Product, on a 
single computer. The primary user of the computer on which 
the Software Product is installed may make a second copy for 
his or her exclusive use on a portable computer. Licensee may 
also store or install a copy of the Software Product on a storage 
device, such as a network server, used only to install or run the 
Software Product on other computers over an internal network; 
however, you must acquire and dedicate a license for each 
separate computer on which the Software Product is installed or 
run from the storage device. A license for the Software Product 
may not be shared or used concurrently on different computers. 

 

3. LICENSE PAK 

If you have acquired this License Agreement in a Serif License 
Pak, you may make the number of additional copies of the 
computer software portion of the Software Product as 
authorized in the Serif License Pak, and you may use each copy 
in the manner specified above. You are also entitled to make a 
corresponding number of secondary copies for portable 
computer use as specified above. 

 

4. PROHIBITIONS 
You may not: modify, prepare derivative works from, translate, 
reverse engineer, decompile, disassemble or otherwise derive 
source code from the Software Product (except to the extent 
that such acts are expressly permitted by applicable law 
notwithstanding this limitation); copy the Software Product 
(except as provided above) or the accompanying 
documentation; rent, transfer, disclose, make available or grant 
any rights in the Software Product (including any 
accompanying documentation) in any form to any person 
without the prior written consent of Serif; remove any 
proprietary notices, labels, or marks on the Software Product 
(including any accompanying documentation); use the Software 
Product in any manner that infringes the intellectual property or 
other rights of another party; or use the Software Product to 
provide on-line or other database services to any other person. 

 

5. RETENTION OF RIGHTS; TERMINATION 

This License Agreement does not constitute a sale. All title, 
trade secrets, copyrights, patents and other intellectual rights to 
the Software Product, its accompanying documentation and any 
copy made by Licensee remain with Serif, and Licensee hereby 
agrees to preserve and acknowledges the foregoing. Licensee 

further agrees and acknowledges that the Software Product and 
all copies thereof are Serif’s exclusive property and constitute a 
valuable trade secret of Serif. Licensee further agrees and 
acknowledges that unauthorized copying of the Software 
Product or the accompanying documentation, or failure to 
comply with any of the provisions hereof (each, a “Terminable 
Event”), will result in automatic termination of this License. In 
the event of a violation of this License by Licensee, Serif 
reserves and shall have available all legal remedies. 

 

6. TERM OF LICENSE FOR TRIAL VERSION 
SOFTWARE 
The License pertaining to a trial version of the Software 
Product (a “Trial Version”) shall expire in accordance with the 
terms as set forth in the installation process for the Trial 
Version along with the designated trial period as set forth in the 
trial program.  

 
7. LIMITED WARRANTY AND DISCLAIMER 
Serif warrants that, for a period of ninety (90) days after 
delivery, the diskettes or CD-ROMs on which the software 
included in the Software Product is furnished will, under 
normal use, be free from defects that prevent Licensee from 
loading the Software Product on a computer. Serif’s entire 
liability and Licensee’s exclusive remedy under this warranty 
will be, at Serif’s option, to (a) use reasonable commercial 
efforts to attempt to correct or work around errors, or (b) to 
replace the Software Product with functionally equivalent 
Software Product, on diskettes or CD-ROM, as applicable or (c) 
return the price paid for the Software Product, in each case 
upon return of the Software Product to Serif together with a 
copy of your receipt for the purchase thereof. This Limited 
Warranty is void if failure of the Software Product or hardware 
has resulted from accident, abuse, or misapplication. Any 
replacement Software Product will be warranted for the 
remainder of the original warranty period or thirty (30) days, 
whichever is longer. Outside the United States, neither these 
remedies nor any product support services offered by Serif are 
available without proof of purchase from an authorized non-
U.S. source. The Software Product is licensed to you on an “as 
is” basis without any warranty of any nature. 

 
8. NO OTHER WARRANTIES 
Except for the above express limited warranties, Serif and its 
suppliers make and licensee receives no warranties or 
conditions, or terms, express, implied, statutory, or in any 
communication with licensee. To the maximum extent 
permitted by applicable law, Serif and its suppliers disclaim all 
other warranties and conditions, either express or implied, 
including, but not limited to, implied warranties of 
merchantability, fitness for a particular purpose, title and non-
infringement, with regard to the software product and the 
provision of or failure to provide support services. Licensee 
shall be solely responsible for the selection, use, efficiency and 
suitability of the software product and serif shall have no 
liability therefor. Serif shall have no liability for, nor obligation 
to indemnify licensee regarding actions alleging the 
infringement of proprietary rights by the software product. Serif 
does not warrant that the operation of the software product will 
be uninterrupted or error free or that the software product will 



meet licensee’s specific requirements. The Limited Warranty 
gives you specific legal rights. You may have others, which 
vary from state/jurisdiction to state/jurisdiction. 

9. LIMITATION OF LIABILITY 
In no event will Serif or its suppliers be liable for loss of data, 
corruption, lost profits, cost of cover, or other special, 
incidental, punitive, consequential, or indirect damages arising 
from the use of the software product (including any 
accompanying documentation), however caused and on any 
theory of liability. This limitation will apply even if Serif or an 
authorized distributor has been advised of the possibility of 
such damage. In no event will Serif’s liability exceed the 
amount paid for the software product. Licensee acknowledges 
that the amounts paid by licensee for the software product 
reflect this allocation of risk. Some states or other jurisdictions 
do not allow the exclusion or limitation of liability for 
incidental or consequential damages, so the above limitations 
and exclusions may not be applicable in certain instances. None 
of the above affects the statutory rights of licensees residing in 
the United Kingdom. 

 

10. NOT FOR RESALE SOFTWARE 

If the Software Product is labeled “Not for Resale” or “NFR,” 
then, notwithstanding section 1 of this License, your use of the 
Software Product is limited to use for demonstration, test, or 
evaluation purposes.  
 

11. NO RENTAL; OTHER TRANSFERS 
You may transfer this License to another computer or 
workstation only on a permanent basis (that is, with no intent to 
transfer again) provided the computer, workstation, or other 
digital electronic device from which you have transferred this 
License no longer accesses or otherwise utilizes the Software 
Product, and the Software Product is used in accordance with 
the terms of this License Agreement.  

 

12. TERMINATION 
You may terminate this License Agreement at any time. Serif 
may terminate this License Agreement if you fail to comply 
with the terms and conditions of this License Agreement. In 
either event, you must destroy all copies of the Software 
Product.  

 

13. UPGRADE 
If this License is an “Upgrade,” you must have a valid license 
for the Prior Software for this License Agreement to be valid, 
and this License Agreement must be used to replace such 
license for the Prior Software. The total number of license 
“Upgrades” you may acquire may not exceed the total number 
of computers, workstations, or other digital electronic devices 
that were licensed to access or otherwise utilize the Software 
Product at the time you upgraded the Software Product. 

 

14. GUIDELINES FOR THE USE OF DIGITAL 
CONTENT 

This product contains numerous clipart and photo images 
and/or video and audio media files (collectively referred to as 
the “Digital Content”) which are either owned by Serif or 
licensed from a third party. As a user of this product you are 
free to use, modify, and publish the Digital Content as you wish 

subject to the restrictions set out below. If you are uncertain as 
to whether your intended use complies with the guidelines set 
out below, we recommend that you seek the advice of your own 
attorney or legal counsel. 

 

A. YOU MAY, subject to any restrictions set out below: 

1. Incorporate any Digital Content into your own original work 
and publish, display, and distribute your work in any media. 
You may not, however, resell, sublicense, or otherwise make 
available the Digital Content for use or distribution separately 
or detached from a product or Web page. For example, the 
Digital Content may be used as part of a Web page design, but 
may not be made available for downloading separately or in a 
format designed or intended for permanent storage or reuse by 
others. Similarly, clients may be provided with copies of the 
Digital Content (including digital files) as an integral part of a 
work product, but may not be provided with the Digital Content 
or permitted to use the Digital Content separately or as part of 
any other product; 

2. Make one (1) copy of the Digital Content for backup or 
archival purposes. 

 

B. YOU MAY NOT: 

1. Create scandalous, obscene, defamatory, or immoral works 
using the Digital Content nor use the Digital Content for any 
other purpose prohibited by law; 

2. Use or permit the use of the Digital Content or any part 
thereof as a trademark or service mark, or claim any proprietary 
rights of any sort in the Digital Content or any part thereof; 

3. Use the Digital Content in electronic format, on-line, or in 
multimedia applications unless (a) the Digital Content is 
incorporated for viewing purposes only and (b) no permission is 
given to download and/or save the Digital Content for any 
reason; 

4. Rent, lease, sublicense, or lend the Digital Content, or a copy 
thereof, to another person or legal entity. You may, however, 
transfer all your license to use the Digital Content to another 
person or legal entity, provided that (a) you transfer the Digital 
Content and this License, including all copies (except copies 
incorporated into your work product as permitted under this 
License), to such person or entity, (b) that you retain no copies, 
including copies stored on a computer or other storage device, 
and (c) the receiving party agrees to be bound by the terms and 
conditions of this License; 

5. Use any Digital Content except as expressly permitted by this 
License. 

 

15. MISCELLANEOUS 
This Agreement shall not be governed by the 1980 U. N. 
Convention on Contracts for the International Sale of Goods; 
rather, this Agreement shall be governed by English law. This 
Agreement constitutes the entire agreement between Serif and 
Licensee and supersedes all prior agreements, understandings, 
communications, advertising, proposals or representations, oral 
or written, by either party. If any provision of this Agreement is 
held invalid or unenforceable, such provision shall be revised to 
the extent necessary to cure the invalidity or non-enforceability, 
and the remainder of this Agreement shall continue in full force 
and effect. This Agreement shall be amended only by an 
executed writing by authorized representatives of both parties. 



How to contact us 

Our main office (USA, Canada): 
The Software Center 
13 Hampshire Drive, Suite 12, Hudson NH 03051 

Main   (603) 889-8650 
Registration  (800) 794-6876 
Single Unit Sales  (800) 55-SERIF or 557-3743 
Technical Support (603) 886-6642 
Customer Service  (800) 489-6720 
General Fax  (603) 889-1127 

Technical Support E-mail support@serif.com 
 

European office (UK, Europe): 
The Software Centre 
PO Box 2000, Nottingham, NG11 7GW, UK 

Main   (0115) 914 2000 
Registration  (0500) 454 645 
Sales   (0800) 376 4848 
Technical Support* (0115) 914 9090  
Customer Service* (0115) 914 9090 
General Fax  (0115) 914 2020  

*Local rate (UK only) (0845) 345 6770 

Technical Support E-mail support@serif.co.uk 

Online 
Visit us on the Web at http://www.serif.com 
Serif Newsgroups  news://news.serif.com 

International 
Please contact your local distributor/dealer. For further details please 
contact us at one of our phone numbers above. 
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Welcome 

Ready to add a new dimension to your Web graphics projects, digital 
movies, presentations, or desktop publishing? DVDPlus will take you 
there! And no special skills are required—whether you use Wizards to 
create and customize instant scenes, or construct your own from 
scratch. DVDPlus puts all the tools and resources you’ll need within 
easy reach. You just pick and choose, mix and match—embellish and 
tweak to your heart’s content. The professional-quality results will 
amaze you! 

Registration, Upgrades, and Support 
If you see the Registration Wizard when you launch DVDPlus, please 
take a moment to complete the registration process. Just call Serif toll-
free and provide the installation number and code shown. We’ll give 
you a personalized registration number in return. Remember, if you 
need technical support please contact us. We aim to provide fast, 
friendly service and knowledgeable help. 

Installation 

What you need to run DVDPlus 
First of all, you’ll need a system that runs a recent version of Windows 
with adequate speed. If you need help installing Windows or setting up 
your printer, refer to Windows documentation and help (see below). 

♦  IBM compatible Pentium-class PC with CD-ROM drive and 
mouse (or other Microsoft compatible pointing device); 700MHz 
CPU minimum (1GHz recommended) 

♦  Microsoft Windows® 98, 98SE, Me, 2000, or XP operating system 

♦  128MB RAM (256MB recommended) 

♦  80MB minimum free hard disk space 

♦  SVGA graphics card (at 16-bit or higher color depth) 

♦  Recommended accessories: CD-Writer/Re-Writer; DVD Player 

Additional disk resources and memory are required when editing large 
or complex documents. 
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What you need to know 
If you’re new to Windows computing, you will find it much easier if, 
before installing and using DVDPlus, you spend a little time becoming 
familiar with the operating environment. (From the Windows desktop, 
click the Start button at the lower left and choose Help.) 

First-time install 
To install Serif DVDPlus, simply insert the CD-ROM into your CD-
ROM drive. The AutoRun feature automatically starts the Setup 
process. (If it doesn’t, follow the manual install procedure described 
below.) 

Just answer the on-screen questions to install the program. You will be 
given the choice between a Recommended install (which optimizes 
performance by loading speed-critical files to your hard drive for best 
performance) or a Custom install (which lets you specify the files you 
want copied to your hard drive). 

Manual install/re-install 
To re-install the software or to change any part of the installation at a 
later date, select Settings/Control Panel from the Windows Start 
menu and then click on the Add/Remove Programs icon. Make sure 
the correct CD-ROM is inserted into your CD-ROM drive and then 
simply follow the on-screen instructions. To install just one particular 
component to your hard drive, choose the Custom option and check 
only that component.  
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Overview 

DVDPlus gives you the ability to author your own DVD, VCD, or 
SVCD format discs. This means that you can now create discs 
containing all your own media and image files complete with 
personalized front-end menus in a style of your own choosing. Whether 
you’re archiving all those huge files cluttering up your computer, or 
creating a unique “director’s edition” of your own holiday videos, 
DVDPlus is up to the task! If you’re new to this digital domain—or just 
a first-time DVDPlus user—here’s a brief overview of how the process 
works.  

♦  In A Nutshell... 
Your DVDPlus project file serves as a sort of “middle manager” 
between your content—the video or image source files that you’re 
working with—and your output: the disc you’ll be burning. 
DVDPlus doesn’t alter your original files. It just keeps track of the 
choices you make: what content to include on a disc, and how you 
want to structure that content. For example, you can arrange the 
disc files in any order, and design menus to enable viewers to 
navigate through the material. 

♦  Add Your Content 
After starting a project, the first step is usually 
selecting the media files (video and/or still 
images, or Serif MoviePlus projects) you want 
to include on the disc, and adding them as 
titles to your project. The DVDPlus Contents 
gallery displays the titles as a convenient list.  
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♦  Design Your Structure 
Simply by rearranging the order of titles in the gallery, you can 
change the sequence in which they’ll be played back on the disc. 
As you add titles, DVDPlus 
automatically creates navigational 
menus that will let your viewers access 
your content in any order they choose. 
Jumping to the start of any title will be 
as easy as clicking an onscreen menu 
button. If you’re creating a DVD, you 
can even go further and add chapter 
stops marking the start of specific scenes. Chapters add another 
level to the menu structure, so that viewers can jump straight to a 
scene instead of having to play or search through the whole file. 
To simplify browsing, you can add your own meaningful menu 
text to identify each title and chapter—no need for cryptic file 
names!  

♦  Enhance Visual Elements 
Whatever your intended output, you’ll 
probably want to enhance the viewer’s 
experience by choosing a visual theme for 
your menus. You can pick a preset theme 
from the wide variety on view in the 
DVDPlus Studio, then customize its various 
attributes, such as background image, layout, buttons, and text 
styles.  

♦  Playback and Preview 
And at any time, you can play back individual titles or preview 
your disc-in-progress. In Preview mode, the  
Playback window simulates the operation of  
a DVD player, complete with an onscreen  
remote control handset.  

♦  Time to Burn! 
Recording an output disc to any format—VCD,  
SVCD, or DVD—is simple and straightforward.  
DVDPlus automatically detects the format of your  
files and converts them to the appropriate format for  
the disc that you are creating. You can even set specific output 
properties for each video file—for example, a lower bitrate in 
order to squeeze more content onto a disc, or a different screen 
aspect ratio for standard or letterbox display. 
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 Starting a Project 

Once DVDPlus has been installed, you’ll be ready to start. Setup adds a 
Serif DVDPlus icon to the Programs submenu of the Windows Start 
menu. 

�  Use the Windows Start menu to start DVDPlus, or if 
DVDPlus is already running choose New from the File menu (or 
click the New button on the toolbar). 

DVDPlus launches and displays an empty Untitled project.  

  

The decks are now cleared and ready for you to bring your media and 
graphic files into the project. Your DVDPlus project file is basically a 
“decision list” that keeps track of the choices you make: what content 
to place on the output disc, and how to structure that content. In other 
words, it’s a sort of middle manager between the video or image source 
files that you’re working with, and the disc you’ll be burning. You can 
save and reopen project files as needed. Once you’ve decided on the 
format and size of the output disc, you can record those settings in 
DVDPlus (see below). As you continue to build your project, you can 
customize the workspace to suit your needs. We’ll cover all of these 
steps in the following chapters. 

 To save a project at any time, click the Save button on the 
toolbar, or choose Save from the File menu. (To save under a different 
name, choose Save As....) In the dialog, select a new project name and 
click OK, or click Cancel to close without saving. The file will be 
saved as a DVDPlus (.DVP) Project file.  

Contents 
window 

Studio 

Preview 
window 
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 DVDPlus works with one project file at a time. To open an 
existing project, click the Open button on the toolbar, or choose 
Open... from the File menu. In the dialog, select the project name and 
click OK to open, or click Cancel to close the dialog and revert to the 
current project. The Contents window displays the gallery of media 
files already imported and the Playback window shows the first page 
menu using the project menu theme.  

Selecting the output disc format and size 
When you know the disc format (DVD/VCD/SVCD) and the size of 
the output disc that you will be burning, it’s a good idea to enter those 
details into your DVDPlus project. As you continue to add content, 
DVDPlus can then display how much free disc space remains and 
provide a warning if the project size exceeds the limit. You can tell at a 
glance whether you’ll be able to fit more files into your project before 
trying to import them.  

Note: You can select or change the disc format and video standard at 
any time, right up until you’re ready to burn a disc. For accurate 
onscreen feedback on the HintLine, it’s a good idea to make your 
selection early on. For further information on disc formats and video 
standards, see the Technical reference. 

To select the output disc format and size, select the 
format (DVD/SVCD/VCD) to be used from the 
Disc Format box on the toolbar. The currently 
selected disc format appears at the far left of the 
HintLine. You’ll see a HintLine message if a 
suitable drive is not currently online. For example, you’ll need a DVD 
burner (not a recordable CD drive) to create a disc in the DVD format. 
In the Disc Size box below the Contents window, select the disc size. 
DVDPlus displays the free disc space 
remaining, and other data about your project, 
at the lower left of the workspace and on the 
HintLine.  

You may also need to tell DVDPlus what video standard (PAL or 
NTSC) you intend to use. DVDPlus will normally burn a disc using the 
video standard you selected at installation, but you can change the 
standard if need be. Simply choose Options... from the View menu, 
select either “PAL” or “NTSC” from the Standard list, then click OK. 

 



 
Adding Content and 
Structure 
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Once you’ve created a project file (see the previous chapter), you are ready to 
prepare your output disc by adding content and designing a structure that 
viewers can use to navigate through the material. Adding content means 
selecting the media files (video and/or still images) you want to include on the 
disc, and adding them as titles to the DVDPlus Contents gallery. If you like, you 
can use drag-and-drop to change the order in which titles appear in the gallery, 
which corresponds to the sequence in which they’ll be played back on the disc.  

The linear sequence in which titles appear is just one aspect of your disc’s 
structure. DVDPlus automatically creates a navigational menu structure based 
on the content you’ve added. If you’re creating a DVD you have the further 
option of adding chapter stops to locate specific scenes within each title. At any 
time, you can play back individual files as described below, or preview your 
disc-in-progress (see Chapter 4). 

Note: DVDPlus does not support the creation, capture, or editing of media 
files—so make sure all your content is accessible on your computer before 
trying to add it. 

Adding Media Files as Titles 

 To add file(s) to your project, click the Add Files button on the 
toolbar, or choose Add Files from the File menu. In the dialog, click on 
a single file to select it, or Ctrl-click to select multiple files (Shift-click 
to select a range of files). Click Open to import, or Cancel to close the 
dialog.  

The files you’ve added appear as separate titles in the Contents gallery, 
the project size readout on the HintLine updates, and the Disc Size 
indicator at the lower left updates to reflect the amount of free space 
remaining on the disc type you’ve selected. Note that “titles” in 
DVDPlus are simply pointers to the source files you’ve designated; the 
source files themselves are never altered in any way. 

In the gallery, the entries for each title 
convey information about them and let 
you rearrange the title sequence. When 
you select a title’s entry, buttons appear 
that let you play back the source file, 
access its properties, or remove the title 
from the project as needed. 
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To rearrange the title sequence, drag a title’s gallery entry up or down 
and drop it at the desired location in the list. The order in which titles 
appear in the gallery corresponds to the order in which they’ll be on the 
output disc. 

Playing Back Titles 
Once you have added a media file as a title, you can play it back in the 
Playback window. Image files play back for a standard duration of five 
seconds, while MoviePlus (.MVP) projects play as single, continuous 
movies. 

 To play back a title, double-click its entry in the Contents window 
gallery, or select its gallery entry and click the Play button. You can 
also right-click the entry and choose Play, or double-click the title’s 
thumbnail on the menu page displayed in the Playback window. (See 
the next section for more on menu pages.) 

 

The source file begins to play in the Playback window. You can use the 
control buttons below the playback monitor to view different portions 
of the file, and the thumbnail buttons at the lower right to update the 
menu thumbnail for a chapter or title. (For details, see the next 
chapter.) By the way, if you’re designing a DVD with chapters, you 
can play a specific chapter in a similar way: by first clicking the title in 
the Contents tree, then double-clicking the chapter’s gallery entry.  

 
 Start Back Play/Pause Stop Forward End 
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 Should you decide you don’t want to include a particular title on 

your disc, you can remove it from the project by selecting its gallery 
entry, then clicking the Remove button (or right-clicking the entry and 
choosing Remove). DVDPlus removes the title from the gallery 
without altering the original source file, and adjusts the menu page 
structure in the Contents tree as needed. 

Setting title properties 
It’s a good idea to check each video title’s properties to make sure 
DVDPlus has correctly determined the information for the source clip. 
DVDPlus picks standard output settings for the disc format you’ll be 
burning (see the previous topic), but you can change these settings on a 
title by title basis. For example, you might want to set a lower bitrate in 
order to squeeze more content onto a disc, or change the screen aspect 
ratio used to display a particular video clip.  

 To check a title’s properties, select its gallery entry and click the 
Title Properties button (or right-click the entry and choose 
Properties). 

 

In the Title Properties dialog, check that the Source Properties are 
correct for the title. Settable source properties include Pixel aspect 
ratio and Interlacing. If in doubt, leave the default settings; see online 
help for details. To specify a different output format for the source clip, 
enter different values under Destination Properties. (For details on 
output properties for various disc formats, see Chapter 5.)  

To record the new destination settings, which will be applied when you 
burn the output disc, click OK. Or, for an immediate preview of the 
converted clip, click Convert Now. Note that DVDPlus never alters 
your source files in any way; it generates a separate version of the 
original material. 
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Menu Structure (Contents Tree) 
As you continue to add media files as titles in the Contents gallery, 
DVDPlus automatically creates a navigational menu structure based 
on the content you’ve added. Menus let your viewers access your 
content in a non-linear way, as opposed to the one linear sequence in 
which titles are burned onto the disc. Each title gets its own menu 
entry, so viewers can click the menu buttons to jump to the start of each 
title.  

As it develops, the menu structure appears in the upper panel of the 
Contents window—called the Contents tree because it resembles an 
upside-down tree with branches. At the top level is en entry for the 
Project itself, i.e. the main disc menu. Depending on the number of 
titles you’ve added and the theme you’ve selected (see the next 
chapter), the disc menu may have more than one page listed under it. 
Some themes allow more titles per menu page than others. As you add 
or subtract titles, DVDPlus automatically manages the menu pages for 
you. You have full control over the theme as well as visual elements 
such as the menu text for each title, the background and button styles, 
etc.  

If you’re designing a DVD and have added chapters to one or more 
titles, DVDPlus adds menu pages for the chapter stops you’ve added. 
These appear in the Contents tree as a sub-level under the title’s entry 
(for example, under “voulezvcd” on the right below):  

 
Standard disc (titles) DVD (titles and chapters) 

To expand the Contents tree, click the  symbol next to an entry; to 
collapse a branch, click . To display a particular menu or chapter page 
in the Playback window, click the its entry in the Contents tree. The 
gallery below the Contents tree displays entries for the titles or chapters 
associated with the selected page. (If the Playback window is paused, 
you won’t see the menu. Click the Stop button to return to the menu.) 
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Adding Chapter Stops (DVD Only) 

We’ve just seen how DVDPlus adds a menu structure for the titles 
(media files) you add to your project. Chapters, available with DVD 
projects only (not for VCD or SVCD output discs), are another way of 
enhancing this navigation structure. You can add markers called 
chapter stops that index specific frames within a video title, so that 
viewers can jump straight to their favorite scenes instead of having to 
play or search through the whole file. 

It’s easy to insert chapter stops while you’re previewing titles in the 
DVDPlus Playback window. DVDPlus automatically adds and 
manages menu pages for the chapters as you add them. (Before adding 
chapter stops, make sure you’ve selected “DVD” as your Disc Format 
on the toolbar.) 

To create a chapter within a title, first select the title’s gallery entry in 
the Contents window. Then click the Play button to play the file and 
use the playback controls to locate the first frame of the scene you want 
to mark as a chapter. It works better if you pause for a still frame, but 
you can also mark a frame as the video plays. (But don’t click Stop or 
you’ll cancel playback!)  

 At the start of the scene you want to mark, click the Add Chapter 
button and a new chapter marker appears on the playbar, with the new 
chapter number displayed below it. A small image (the chapter 
thumbnail that will represent the chapter on the menu page) appears 
just to the right of the playbar.  
 

 

Initially, the image shows the frame you marked as the start of the 
scene. If this isn’t representative of the chapter’s content, you can 
change the menu thumbnail by displaying any other frame in the same 
chapter and clicking the thumbnail button. The actual chapter stop (the 
first frame of the scene) remains the same. 

Chapter thumbnail 
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When you add chapter stops to a title, the Contents tree adds a new 
sub-level consisting of one or more menu pages with a button for each 
chapter. As you continue to add (or remove) chapters, DVDPlus 
automatically manages the menu pages for you. The Contents gallery 
now does “double duty,” displaying entries for either titles or chapters 
depending which item you’ve selected in the Contents tree. Of course, 
you can’t rearrange existing chapters, since their sequence conforms to 
that of the movie file itself, but if you add or remove chapters you’ll 
see the chapter entries update in the gallery.  

 To play back a chapter, first click the title in the Contents tree. The 
lower gallery displays entries for chapters within the title. Then you 
can display the chapter in the same way that you displayed a title. 
Double-click the chapter’s gallery entry or select it and click the Play 
button; right-click the entry and choose Play; or (in the Playback 
window) display the menu page that lists the chapter and double-click 
its thumbnail. 

 Should you decide to change the chapter structure, you can remove 
a chapter stop just as easily as you added it. Just select its Contents 
gallery entry and click the Remove button (or right-click the entry and 
choose Remove).  

 You can also play the chapter to be removed and while it is 
playing click the Remove Chapter button in the Playback window. 
Removing the chapter stop effectively makes the following scene part 
of the previous chapter, if any. DVDPlus adjusts the menu page 
structure in the Contents tree as needed. 

 

 



 
Designing Visual 
Elements 
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Whatever your intended output, you’ll probably want to choose a theme (menu 
style) and customize the visual elements that will enhance your viewers’ 
experience. 

Choosing a Theme (Menu Style) 
DVDPlus provides you with a host of menu styles known as themes. 
Each project has one customizable theme; in a new Untitled project, the 
default theme is “Album” from the Abstract category. Each theme 
consists of the following visual attributes:  

♦  A screen layout that defines the spatial arrangement of menu 
items and buttons around the screen 

♦  A background image used on the menu screen 

♦  A frame style that defines the appearance of onscreen menu items 

♦  A button style that defines the appearance of the buttons used to 
navigate around menu pages 

♦  Text formats that dictate the graphic style, artistic effects, color, 
and size of text used on menu screens 

To select a starting theme, check Studio on the 
View menu to display the Studio window, if it is 
not already displayed. Display the Studio’s 
Themes tab and browse the gallery of Themes 
thumbnails. When you see a gallery item you 
like, click on it to apply it to your project.  

The result appears in the Playback window. You 
can either use the theme “as is” or go on to use 
the DVDPlus Studio to customize its layout, 
background, frame style, button style, and/or text 
styles as detailed in the next section.  

 Should you wish to delete a style change and revert to the 
previous style, either click the Undo button on the toolbar or choose 
Undo from the Edit menu. 
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Customizing Visual Elements 
As explained in the previous chapter, DVDPlus gives each title you add 
to your project (and each chapter, if you’ve added them to a DVD) a 
menu entry that will become part of the navigation structure of your 
finished disc. The disc as a whole has a main menu of its own. You can 
customize how these entries—and the menus themselves—will appear 
to your viewers. The DVDPlus Studio offers a wide variety of choices 
to help you enhance your viewers’ visual experience. 

Menu text and thumbnails 
To change the disc’s main menu text, first select the Project entry in 
the Contents tree. The main disc menu appears in the Playback 
window. In the Playback window, double-click the Disc Title 
placeholder (or current text) and retype it.  

For each title and chapter, the menu entry consists of identifying menu 
text and a thumbnail. When you import media files, the menu text for 
each resulting title defaults to the name 
of the original file. Because certain file 
names may not mean much to your 
viewers, you can alter the menu text if 
you wish using either the Contents 
window or the Playback window.  

There are two basic ways to change a 
title’s menu text. You can either select 
the title’s gallery entry in the Contents 
window, then select and retype the 
caption at the bottom of the entry, or (in 
the Playback window) double-click on 
the menu text and retype it. Either way, 
the text change will be reflected in both 
the Contents gallery and the actual menu 
item in the Playback window. (Changing 
the menu text won’t affect the original 
file name, which will still appear in the 
gallery entry.)  

Changing a chapter’s menu text is equally simple. When you click the 
title in the Contents tree, the lower gallery displays entries for chapters 
within the title. Then (as for titles) you can either select the chapter’s 
gallery entry and retype its caption, or double-click on the menu text in 
the Playback window and retype it. 
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Initially, title and chapter thumbnails show the first frame of the video 
segment. It’s a simple matter to change either kind of thumbnail using 
the Playback window. 

 

 

Play back the title and locate the new frame that you want to use as the 
thumbnail. (To pick a new chapter thumbnail, you must be within the 
chapter.) It’s preferable to pause for a still frame, but you can also grab 
a frame as the video plays. When you find the frame you want, click 
the Set Title Thumbnail button (the image at the far lower right) or the 
Set Chapter Thumbnail button (at the near lower right). In either case, 
redefining the thumbnail doesn’t change the first frame of the title or 
the position of the chapter stop. 

Theme 
Once you’ve selected a theme, you can use the DVDPlus Studio to 
customize its layout, background, frame style, button style, and/or 
text style. Pick and mix from the galleries to design a menu style of 
your liking, then save it as a new theme under a name of your own 
choosing for use in a later project. You can even import your own 
graphics and save them as background files with which to further 
personalize your menus!  

 

To change the layout, frame style, or button style, display the 
appropriate Studio tab and browse the gallery of thumbnails. Click on a 
gallery item to apply it to your project. The result appears in the 
Playback window. 

When changing the background, use the Backgrounds tab in the same 
way. If you want to bring in a new background of your own, click the 
New... button. Use the dialog to select an image file and click OK, or 
click Cancel to close without saving. 

If you change your mind about a style change, you can revert to the 
previous style by clicking the Undo button on the toolbar or choosing 
Undo from the Edit menu. 

Set Chapter Thumbnail Set Title Thumbnail 
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At any time you can save the current combination of style attributes as 
a theme on the Themes tab, for use in a later project. Display the 
Themes tab gallery where you want to save the theme, and click the 
Save... button. In the dialog, select a new theme name and click OK. A 
thumbnail for the theme appears in the current Themes tab gallery. 
(Should you want to remove a custom theme you’ve added, simply 
right-click its thumbnail and choose Remove.) 

Changing text styles 
Above, we explained how to alter the actual menu text that appears for 
the disc and for each title/chapter menu entry. You can also customize 
the appearance of these items by choosing a different text style. Each 
theme actually incorporates two text styles: one for the disc title (i.e. 
the disc’s menu text) and one for all menu items. Using the Studio’s 
Text tab, you can pick a preset text style or define a new one of your 
own.  

♦  The Text Styles category provides a gallery of preset text styles, 
each with a specific font, color, point size, and artistic effect.  

♦  The Text Effects category lets you apply a different effect to the 
selected text.  

♦  The Fonts category lets you change the font, point size, and/or text 
color. 

To change the text style, first select the text you want to reformat in the 
Playback window (either the disc title itself or any menu entry). A box 
appears around the selected item. Use the Studio’s Text tab to apply 
your changes. Applying a preset text style 
is simply a matter of opening the Text 
Styles category and clicking a gallery 
sample.  

To update an attribute, select the Text Effects or Fonts category and 
make your choices. To remove the text effect, select None from the 
Text Effects list. When you select Fonts, besides changing the font you 
can also change the point size by clicking in the Size box at the top of 
the gallery and either selecting or typing a new size, or choose a new 
text color by clicking in the Color box to the right of the Size box. 
(Use the dropper or numeric controls to define a new color in the Select 
text color dialog.) You’ll see the updated text in the Playback window.  
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Any changes you make to the current text style become part of the 
project’s theme and will be saved along with your project, but at any 
time you can also save the text style separately on the Text tab, for use 
in a later project. To do so, click the Save... button on the Text tab and 
use the dialog to pick a new style name. You’ll see a new thumbnail for 
your theme in the Text Styles category. To remove a custom text style 
later, right-click its thumbnail and choose Remove. 
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Burning (recording) an output disc to any format—VCD, SVCD, or DVD—is 
simple and straightforward. But before you use up a perfectly good recordable 
disc, you can double-check your project’s content and structure using Preview 
mode. So far, we’ve only considered using the Playback window in Edit mode: 
using its control buttons to review single titles, mark menu thumbnails, etc. as 
you are assembling content and developing the structure for your disc. But at 
any point in the process you can use the Playback window to simulate the 
operation of a DVD player, complete with an onscreen remote control handset. 
You can actually navigate the menus and use any of the handset buttons to 
check out the operation of the project. 

Previewing Your Project 
Preview mode lets you verify that the project displays exactly as you 
intended when viewed on your TV or computer, titles play in the 
expected order, visual elements appear as desired, and menu navigation 
works correctly.  

 To preview your project, click the Preview button on the toolbar. 
The Playback window switches to Preview mode (hiding the Contents 
window and Studio) and displays the main disc menu, with a virtual 
DVD player handset to the left of the screen. The word “Preview” 
appears at the far right of the HintLine to denote the current mode. If 
you want to frame edge regions that may not be displayed on a standard 
television, first check TV Safe Zone on the View menu (more about 
this below). 
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Click the handset buttons to simulate disc playback: 

 

Button Function 

Numeric Plays associated item on menu page (either title or chapter) 

Direction For VCDs and SVCDs, selects next item on a page 
For DVDs, selects next menu item in each direction 

Select Selects next menu level down, or (bottom level) plays item 

Next, 
Previous 

Selects next or previous menu page 

Stop Stops playback 

Play Starts playback of selected or highlighted item 

Pause Pauses/resumes playback 

Rewind Scans backward to start of title, then returns to menu 

Fast Forward Scans forward to end of title, then returns to menu 

Return Reverts to previous selection 

Menu Stops playback and redisplays the previous menu 

 

Menu 

Previous 

Stop 

Rewind 

Direction 

Return 

Numeric 

Select 

Next 

Play 
Pause 

Fast Forward 
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 To close Preview mode and return to Edit mode, click the Edit 
button on the toolbar. The Playback window switches to Edit mode, 
displaying the Contents and Studio windows. The screen appears 
exactly as before, for example keeping the same Studio tab settings. 
The word “Edit” appears at the far right of the HintLine to denote the 
current mode. 

The television safe zone 
Standard televisions may not display the full-frame DVDPlus image 
that appears in the Playback window—portions of the image may “fall 
off” the edges of the TV screen and disappear from view. The portion 
of the image that is guaranteed to be visible when viewed on a 
television is known as the television safe zone. You can set the 
Playback window to frame this region by highlighting, with a 
transparent color of your choice, the portions of the screen that may not 
be visible when viewed on television.  

To show or hide the TV Safe Zone, check or uncheck TV Safe Zone on 
the View menu. With the option checked, a transparent color frame 
around the edge of the Playback window indicates portions that may 
not be visible on a TV screen. 

You can change the color of the TV Safe Zone via View/Options.... 
Click the color box and use the color selection dialog to define a new 
color by clicking in the spectrum regions or entering color values. The 
new color is applied around the edges of the Playback window. 
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Burning a Disc 
Before clicking that “big red button,” step through this checklist to 
make sure you’ve covered all the bases: 

� Have you set the disc format, disc size, and video standard 
correctly? 

� Have you added all the titles you want, without exceeding the 
limits of your disc media? 

� If creating a DVD, have you added chapter stops to enhance 
navigation? 

� Have you checked each video title’s properties to make sure that 
DVDPlus has correctly determined the information for each source 
clip? Do you need to set destination properties for one or more 
titles, for example to conserve disc space?  

� Have you previewed your project to make sure that your content 
and structure are as you intended, and that your chosen theme and 
customized visual elements look satisfactory? 

� Have you saved your project? 

 If you’ve got this far, then you’re ready to burn! Insert a suitable 
recordable disc into the recorder and click the Burn Disc button on the 
toolbar (or choose Burn Disc from the File menu). 

And that’s it! Prior to writing your source files to disc, DVDPlus copies 
and converts them to the format required by the destination media, 
taking into account any property settings you’ve changed for specific 
titles as detailed below.. 
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This chapter gives background information on disc formats and television 
standards. 

Disc Formats 

♦  VCD stands for Video Compact Disc and basically it is a CD that 
contains moving pictures and sound. A VCD has the capacity to 
hold up to 74/80 minutes on 650MB/700MB CDs respectively of 
full-motion video along with quality stereo sound. VCD uses a 
compression standard called MPEG-1 to store the video and audio. 
A VCD can be played on almost all standalone DVD Players and 
of course on all computers with a DVD-ROM or CD-ROM drive 
with the help of a software-based decoder/player. It is also possible 
to use menus and chapters, similar to DVDs, on a VCD and also 
simple photo album/slide shows with background audio. The 
quality of a very good VCD is about the same as a VHS tape-based 
movie but VCD is usually a bit more blurry. 

♦  SVCD stands for Super VideoCD. SVCD is very similar to VCD, 
with the capacity to hold about 35-60 minutes on 74/80 min CDs 
of very good quality full-motion video (using MPEG-2 
compression), along with up to two stereo audio tracks and four 
selectable subtitles. An SVCD can be played on many standalone 
DVD Players and of course on all computers with a DVD-ROM or 
CD-ROM drive with the help of a software based decoder/player. 
It is also possible to use menus and chapters, similar to DVDs, on 
an SVCD and also simple photo album/slide shows with 
background audio. SVCD quality is much better than that of VCD, 
with a sharper picture because of higher resolution. But the quality 
depends how many minutes you choose to store on a CD: fewer 
minutes per CD generally means higher quality. 

♦  DVD stands for Digital Versatile (or Video) Disc. DVDR stands 
for DVD Recordable and DVDRW for DVD ReWriteable. A 
single layer (DVD-5) DVD stores up to two hours of very good 
quality DVD-Video, including several audio tracks in formats like 
stereo, Dolby Digital, or DTS plus advanced menu systems, 
subtitles and still pictures that can be played by standalone DVD 
Players and computer DVD-ROMs. DVD-R/W and DVD+R/W 
support single-sided 4.7GB DVDs (called DVD-5) and double-
sided 9.4GB DVDs (called DVD-10). 
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File Comparison 

 VCD SVCD DVD 

Resolution 352x240 
352x288 

480x480 
480x576 

720x480 
720x576 

Video compression MPEG-1 MPEG-2 MPEG-2 

Video bitrate (kbit/s) 1150 1500-2500 3000-8000 

Audio compression MPEG1 MPEG1 MPEG1, MPEG2, 
AC3, DTS, PCM 

Audio bitrate (kbit/s) 192-448 128-384 192-448 

 

Television Standards 
Different countries use different television broadcast standards. The 
United States, Japan, and a few other countries use the NTSC standard; 
the rest of the world uses PAL (or SECAM, which is similar to PAL). 
NTSC video uses 525 scan lines at 29.97 frames (59.94 fields) per 
second; PAL video uses 625 scan lines at 25 frames (50 fields) per 
second.  

Most NTSC set-top DVD players cannot play PAL-format discs, 
whereas most PAL DVD players and all software players can play both 
formats. DVD, VCD, and SVCD discs can contain video of either 
NTSC or PAL standard, but not both.  

When you install DVDPlus, it uses your Windows country code to 
decide whether you are in an NTSC or PAL country. It will create discs 
in that format unless you specify the other, as described in Chapter 1. 

♦  NTSC is used in the following territories: 
Anguilla, Antigua and Barbuda, Aruba, Bahamas, Barbados, 
Belize, Bermuda, Bolivia, Brazil, British Indian Ocean Territory, 
Canada, Cayman Islands, Chile, Colombia, Costa Rica, Cuba, 
Dominica, Dominican Republic, Ecuador, El Salvador, 
Greenland*, Grenada, Guam, Guatemala, Guyana, Haiti, 
Honduras, Jamaica, Japan, Korea (South), Laos, Marshall Islands, 
Mexico, Micronesia, Myanmar (Burma), Netherlands Antilles, 
Nicaragua, Northern Mariana Islands, Palau (Belau), Panama, 
Peru, Philippines, Puerto Rico, Samoa (American), St. Kitts and 
Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, 
Taiwan, Tonga, Trinidad and Tobago, Turks and Caicos Islands, 
United States, Venezuela, Virgin Islands (American and British).  
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♦  PAL is used in the following territories: 
Afghanistan, Albania, Algeria, Andorra, Angola, Argentina, 
Armenia, Australia, Austria, Azerbaijan, Bahrain, Bangladesh, 
Belarus, Belgium, Benin, Bhutan, Bosnia, Botswana, Brunei, 
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape 
Verde, Central African Republic, Chad, China, People’s Republic 
of, Comoros, Congo, Democratic Republic of (formerly Zaire), 
Congo, Republic of, Cook Islands, Croatia, Cyprus, Czech 
Republic, Denmark, Djibouti, East Timor, Egypt, Equatorial 
Guinea, Eritrea, Estonia, Ethiopia, Falkland Islands (Malvinas), 
Faroe Islands, Fiji, Finland, France, France (Metropolitan), Gabon, 
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, 
Greenland*, Guadeloupe, Guiana (French), Guinea, Guinea-
Bissau, Hong Kong, Hungary, Iceland, India, Indonesia, Iran, Iraq, 
Ireland, Israel, Italy, Ivory Coast (Côte d’Ivoire), Jordan, 
Kazakhstan, Kenya, Korea (North), Kuwait, Kyrgyzstan, Latvia, 
Lebanon, Lesotho, Liberia, Libya, Liechtenstein, Luxembourg, 
Macau, Macedonia, Madagascar, Malawi, Malaysia, Maldives, 
Mali, Malta, Martinique, Mauritania, Mauritius, Mayotte, 
Moldova, Monaco, Mongolia, Montserrat, Morocco, Mozambique, 
Namibia, Nauru, Nepal, Netherlands (Holland), New Caledonia, 
New Zealand, Niger, Nigeria, Niue, Norway, Oman, Pakistan, 
Papua New Guinea, Paraguay, Pitcairn Island, Poland, Polynesia 
(French), Portugal, Qatar, Réunion, Romania, Russia, Rwanda, 
Samoa (Western), San Marino, São Tomé and Principe, Saudi 
Arabia, Senegal, Seychelles, Sierra Leone, Singapore, Slovakia, 
Slovenia, Solomon Islands, Somalia, South Africa, Spain, Sri 
Lanka, St. Helena, St. Pierre and Miquelon, Sudan, Svalbard 
(Spitzbergen), Swaziland, Sweden, Switzerland, Syria, Tajikistan, 
Tanzania, Thailand, Togo, Tokelau, Tunisia, Turkey, 
Turkmenistan, Tuvalu, Uganda, Ukraine, United Arab Emirates, 
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Vietnam, Wallis 
and Futuna Islands, Western Sahara, Yemen, Yugoslavia (Serbia, 
Montenegro, Kosovo), Zambia, Zimbabwe.  

 

.

    


